| energy
technologies

institute

Programme Area: Smart Systems and Heat
Project: EnergyPath

Title: EnergyPath Networks Technical Design & User Guide

Abstract:

This Deliverable comprises a report from The purpose of this document is twofold:

 To provide a consolidated technical description of the EnergyPath Networks (EPN) Tool covering both its design and
data architecture

* To provide a user guide for the EPN Tool.

It is designed to be a ‘living’ document accessible to an ‘expert’ user, but not the original developer, which should be
updated to reflect further developments to the tool. This document reflects R2.1 of the tool. It should be noted that this
document does not describe the functional requirements and specification which have driven the development of the
tool, this is described in detail in the separate EnergyPath Networks Tool Functional Specification

Context:

Energy consultancy Baringa Partners were appointed to design and develop a software modelling tool to be used in
the planning of cost-effective local energy systems. This software is called EnergyPath and will evolve to include a
number of additional packages to inform planning, consumer insights and business metrics. Element Energy, Hitachi
and University College London have worked with Baringa to develop the software with input from a range of local
authorities, Western Power Distribution and Ramboll. EnergyPath will complement ETI’s national strategic energy
system tool ESME which links heat, power, transport and the infrastructure that connects them. EnergyPath is a
registered trade mark of the Energy Technologies Institute LLP.

Disclaimer: The Energy Technologies Institute is making this document available to use under the Energy Technologies Institute Open Licence for
Materials. Please refer to the Energy Technologies Institute website for the terms and conditions of this licence. The Information is licensed ‘as is’
and the Energy Technologies Institute excludes all representations, warranties, obligations and liabilities in relation to the Information to the
maximum extent permitted by law. The Energy Technologies Institute is not liable for any errors or omissions in the Information and shall not be
liable for any loss, injury or damage of any kind caused by its use. This exclusion of liability includes, but is not limited to, any direct, indirect,
special, incidental, consequential, punitive, or exemplary damages in each case such as loss of revenue, data, anticipated profits, and lost
business. The Energy Technologies Institute does not guarantee the continued supply of the Information. Notwithstanding any statement to the
contrary contained on the face of this document, the Energy Technologies Institute confirms that it has the right to publish this document.



y@ . ¥ Baringa

technologies elementenergy
Institute
th
catTAPULT
Energy Systems

Networks

S @Energg%ﬁh

(S3D1) Technical Design and User Guide

CLIENT: Energy Systems Catapult

DATE: 20/02/2017

www.baringa.com



¥% Baringa

Version History

Version Date Description Prepared by Approved by
V11 31/03/2015 Final JG/KP/FT OR
V12 02/04/2015 Minor updates JG OR
V2.0 20/02/2017 | Updated to reflect EPN AB/LH/KP/ JG

R2.1 FT
Copyright

This document is subject to the Technology Contract for Smart Systems and Heat EnergyPath?
Design Tools, between the Energy Technologies Institute LLP and Baringa Partners LLP and
contains confidential and proprietary information.

Confidentiality and Limitation Statement

This document: (a) is subject to contract and shall not form part of any contract nor constitute an
offer capable of acceptance or an acceptance; (b) excludes all conditions and warranties whether
express or implied by statute, law or otherwise; (c) places no responsibility on Baringa for any
inaccuracy or error herein as a result of following instructions and information provided by the
requesting party; (d) places no responsibility for accuracy and completeness on Baringa for any
comments on, or opinions regarding the functional and technical capabilities of any software or
other products mentioned where based on information provided by the product vendors.. Where
specific Baringa clients are mentioned by name, please do not contact them without our prior
written approval.

L EnergyPath is the registered trade mark of Energy Technologies Institute LLP

ETI SSHP — EnergyPath Networks — Technical Design and User Guide 2/118

Baringa Partners LLP is a Limited Liability Partnership registered in England and Wales with registration number 0C303471 and with registered offices at 3rd Floor, Dominican Court, 17 Hatfields, London SE1 8DJ UK.




¥% Baringa

TABLE OF CONTENTS

1. INTRODUCTION .........eiiiiececcrss s s rrrescc e s s s s e e s s nmmmss s s s e s e s s nmmmnssssssseeennnnnnn 6
O B = 7= Yol 4= o YU o T PR 6

1.2, ACronyms and BlOSSArY .....ceeruieriieriiiee ittt st e st e siteesreestee s sbee s sabe e st be e snareesnbeesbeeenaes 6

0 TR U T o 1 PP PPTOPP 7

1.4.  Structure of this dOCUMENT ......viiiiiiie e s 7

2. OVERARCHING TOOL ARCHITECTURE .......eeerrrreecccee s e e e e 9
2.1. Mapping to the Functional Specification.......ccccccuvieeiiiieiiiiee e 9

2.2, SOftWAre COMPONENLS ..eiiiiiiieeiiieie ettt et e et e e et e e e s rree e e sate e e e sabaee e e s eabeeeeennraeessnnens 9

2.3, DeSigN arChit@CLUIE .....covie i e e e e e e e e araae s 10

D S I W o1 = ) A U o1 { U o O OO PSP RRPPO 11
241, 0perating SYSTEM .o 11

2,42, HalOWar. oo cieeeeeiiee ettt ettt e st e e st e e s sate e e s sbaeeessabaeeesennraeessbeeeesans 12

2.4.3.  Parallel COMPULING ..oceoeeiiee ettt seare e e e e e reeee e 12

2.5. Technical configuration of 3™ Party TOOIS........ccceeeiveieveeeeeeceeecreeeeee e 12

3. DATABASE STRUCTURE ..........ooeeeeeeeeeeeeeeennnennnnsnn s snnnnn s s nnnnnns 14
3.1. Management of multiple scenarios in data StruCture.........cccoecveeeircieen e 18

4. TOOL PROCESS FLOW AND SUB-MODULE LIBRARIES.......................... 20
4.1. Basic end-to-end process fIOW .......cooccveiiiiiiiii e 27

5. API SPECIFICATION ... e s s e s seccces e s e e s s nmmm e s s s e e e e s mmmmmnnnnas 29
o B O V=T oY= PP P PP PPPTT PP 29

I N |V, [0 Y o] I T o o] =TSRRI 29

6. INSTALLATION AND CONFIGURATION .......cooiiiieecccccerrre e e e e e eeneees 31
6.1. Underlying software installation .........ccccccueeiioiieii i 31
6.1.1. Overarching Pre-reqUISItES ......cccccccieeeiiiiiee et e e 31

0t 7 oAV o o Vo o TSR 32

6.1.3.  IMS SQL SEIVE ...ttt e e e s e e s 33

B.1.4.  AIMMS ... ittt ettt e e s be e e abeesateas 35

B.1.5. @RISK..ueieeiie e e sare s 39

L T ST =3 oY 1Y o] 11 RS 39

6.1.7. ETI Thermal Efficiency SAP Model........cccccuvvriiiiiiiciiiecee e 40

B.1.8.  AICGIS .. e et ee e e te e e e e s e reeaee s 40

6.1.9. PSS SINCAl..iiiiiiiiiiii it et s sb e st 42

6.1.10. Tool setup and configuration ........ccccceeeeciiieeiiiie e 44

6.2.  Parallel compPULINg SELUP ....c..uiiiiieee e e e re e e e e e e aeneee s 45

6.3, KNOWN SOFtWAIE ISSUBS ..covviiiiiiiiit ittt ettt st e s e e sba e e sabe e sbaessaseesareas 46

7. OVERVIEW OF USER INTERFACE (Ul).....cccoiiiiiiececseerresecccce e e s e e nenees 48
ETI SSHP — EnergyPath Networks — Technical Design and User Guide 3/118

Baringa Partners LLP is a Limited Liability Partnership registered in England and Wales with registration number 0C303471 and with registered offices at 3rd Floor, Dominican Court, 17 Hatfields, London SE1 8DJ UK.




¥% Baringa

% T |V, =Y [ o T =5 ot I 1 PR 48
% S N |- 1V == | o] o OO PPP O ORRRORPRPRPRR 48

7.1.2. GUI formatting CONVENTIONS.......ceicciieeiecieee ettt e 49

7.1.3. Reading and writing to the database.......ccccccceeeciiiiieii e, 49

7.1.4. Adding, modifying and deleting input data.........cccccvveeriiiieicciee e, 50

2% R N ol € 13 U USRS 51

8. OVERVIEW OF SPECIFIC EXCEL UI SCREENS...........cccooiemmmeeireeerrreeeeees 52
8.1. Flexible data entry screen [MCF to POM menu ite€ms] .......coccuviieeeeeeiccciiieeee e 52
3 R 1Y, Lo To [=] | U U UR PRt 53
8.2.1. [Database Man@GeI].....cccciueiieiiiieeeiiiieeectee e ectee e e rre e e e e e e e s e e e s sbre e ae e e naraeas 53

T TR Y10 0 V1= ] RSP URPPRRPRPPPOPRPPUPRt 53
8.3.1. [Monte_Carlo — Set/Parameters and associated sub-menus]..........cc.cu...... 53

8.3.2.  [SIMUIation Man@GEI] ...ccuvveiieiiie ettt et 54

Bh.  [RUNJ tututuuutututitiiuuutttttitrertrereaeeeeaararar.—.—a,a———a—srsrarsrassssssesssssssssssssessssssssssssssssssssssnrssssssnrnnns 54
8.4.1.  [ProCeSS FIOW] .coouvirieiieiiieeiteieee ettt e e eeearr e e e e e e e enabraeeeae s 54

8.4.2. Pathway Optimisation........ccccciiiieiiiiiiie e e 58

S O T Y ol € ) S RPRPRPRRRPPRPPPPPIR 58

8.5, [RESUILS] ittt ee et e e e et e et b e e e e e e eesatarbbraeaeeeeeearbaaaeeeeseaannees 58
0 0 P [ 00 o X @ o F=1 s £ [P URRUURT 58

T ST - Yo ' o 11 o} RSP SRUR PR PRPPPPPPPPRPRt 59
8.6.1.  [Hide all] / [SHOW @ll].eeioueiiieiiiieie ettt 59

8.6.2. S dATA] . uueiiiiiiiiiiiiiiie e e e s e e e e e aae s 59

8.6.3. [Simulation sheets] and associated sUD-MENUS...........evvvereviiiveeveeeeieereereerenes 59

8.6.4.  [WKSCOMMANUBAIS] ..vveiiiiiiiiiiriiieeeeeeiciitreeeeeeeeeetirereeeeeeestraeeeeeeeeenassreesraneeees 59

8.6.5. [Parameter Data Config] .....ccecvieiiiiiiiie et e 60

I N T o o Yol S e | = SR 60

8.6.7. [MCF to Monte_Carlo] and associated sub-menus.........ccccceeeveeeercveeeecnnnenn. 60

9. APPENDIX - SAMPLE USE CASES ...t rre e nr s mmss s nsmmsssens 61
ETI SSHP — EnergyPath Networks — Technical Design and User Guide 4/118

Baringa Partners LLP is a Limited Liability Partnership registered in England and Wales with registration number 0C303471 and with registered offices at 3rd Floor, Dominican Court, 17 Hatfields, London SE1 8DJ UK.




¥% Baringa

9.1. Relation t0 ProCess FIOW ......ccociiiiiiee et e e e 61

9.2.  ArcGIS [A] Load OS data into ArCGIS .......cccovreiiiiieiieiieeeee ettt e e e eeeans 61

9.3. ArcGIS [B] Add new build and existing stock information to OS data...........cccccuueeeenes 63

9.3.1. Steps for editing the OS GIS [Qyers.......ccuvvveieiiccciiieee e 63

9.4. ArcGIS [C] Create a network dataset using OS road information (ITN)..........cccccuveennnns 71

9.4.1. Steps for creating the Network Dataset........ccccueeeeeiieeecciiee e 71

9.5. ArcGlIS [D] Identify building demolition, PV and EVS.........cooccciiieeeeeicciiiieeee e 79

9.5.1. Steps for editing the demolition, PV and EV layers........coceeveiveeiicieececinennn. 79

9.6. ArcGIS [E] Define technology Packages......cc.ueieecuiiiiieciieei e e 85

9.6.1. Steps for editing the technology package layer.......ccccovveciiiieiiiiccciiieeeeeen. 85

9.7. ArcGIS [G] Define existing electricity / heat network features ........ccccceeeveecvecveenenee. 87
9.7.1. Steps for editing the ExistingDHN, ExistingLVFeeder and

ExistingHVFeederLinks Iayers ........cocuiie ittt e 87

9.8. ArcGIS [H] Create clusters and assign coNStraints........cccceecvveeeecieeeeiiieeeeiieeeeecveee s 90

9.8.1. Defining multiple sensitivity cluster definitions.......c.ccccoccceuveeeiiiiicciiiennennnn. 98

9.8.2. Automated feedback on the cluster definition.........cccoocvevriiiiiiiincenncennnennn 99

9.9. ArcGlIS [I] Define inter-cluster connections and mesh options ........ccccceeevcciveeeiiieeeens 99

9.9.1. Defining multiple sensitivities for inter-cluster connection definitions....... 102

9.10. ArcGIS [J] View spatial results from POM .........cccoccvieiieciiiee e 102

9.11. Define number of simulations (and generate Monte Carlo inputs) .................. 103

9.12. Define temporal aggregation........cccee e ceciiiiiie e e 110

9.13. GENEIIC USE CASES...eiiieiiiiiiiiiiteeee e e e ettt e e e s e e e e e e s e sabe bttt e s e sasnereereeeeesesesanns 113

9.13.1. Basic database configuration and management...........ccccceeeecieeecciee e, 113

10. APPENDIX — DATABASE DOCUMENTATION.......cccoiirirrirrrrrrssssssssssssnnnas 116

11. APPENDIX — ER DIAGRAMS FOR PHYSICAL DATA MODEL.................. 117

11.1. Primary database .....c..eeiiciiieiiiee e 117

11.2. HOM Secondary database .......cc.eeeeecieeiiiiiieieecieee s e aee e 117

11.3. SAM Secondary database .........eeeeeecciiiiiiie e 117

11.4. NAM Secondary database........ccueeiecieeei i e 117

11.5. POM Secondary database........c..ueeiecuiieiiiiiiii e 117

12. APPENDIX — CODE DOCUMENTATION.........ccco s 118

12.1. MCF / HOM / NAM / SAM — python APl code descriptions..........cccceeevveeeveennee. 118

12.2. POM — AIMMS identifier DescriptionsS.........ueeeccuieeeeiiiiee e e sveee e 118

ETI SSHP — EnergyPath Networks — Technical Design and User Guide 5/118

Baringa Partners LLP is a Limited Liability Partnership registered in England and Wales with registration number 0C303471 and with registered offices at 3rd Floor, Dominican Court, 17 Hatfields, London SE1 8DJ UK.




¥% Baringa

1. Introduction

1.1. Background

The purpose of this document is twofold:

»  To provide a consolidated technical description of the EnergyPath Networks (EPN) Tool
covering both its design and data architecture

»  To provide a user guide for the EPN Tool.

It is designed to be a ‘living’ document accessible to an ‘expert’ user, but not the original
developer, which should be updated to reflect further developments to the tool. This document
reflects R2.1 of the tool.

It should be noted that this document does not describe the functional requirements and
specification which have driven the development of the tool, this is described in detail in the
separate EnergyPath Networks Tool Functional Specification (Deliverable S1D1).

1.2. Acronyms and glossary

The following tables provide a list of common acronyms and glossary of terms used in relation to
the tool.

Table 1-1 Acronyms
API Application Programming Interface
DB Database
FK Foreign Key
GIS Geographical Information System
GUI Graphical User Interface
HOM Household Options Module
1/0 Input / Output
LA Local Authority
MCF Master Control Framework
NAM Network Analysis Module
oS Ordnance Survey
POM Pathway Optimisation Module
PK Primary Key
RDB Relational Database
SAM Spatial Analysis Module
SSHP Smart Systems and Heat Programme
VBA Visual Basic for Applications
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Table 1-2 Glossary of key terms

Data architecture

Data models

Modular architecture

Module

Sub-module

Software wrapper

1.3. Units

Data architecture is composed of models, policies, rules or standards that govern which data is
collected, and how it is stored, arranged, integrated, and put to use in data systems and in
organizations

Generally divided into 3 layers

. Conceptual data model is a summary-level representation most often used on strategic data
projects to describe an entire enterprise

. Logical data model is an attributed data representation (typically but not always containing
entity relationships) independent of the database (or other data implementation option) which
describes data requirements from the business point of view

. A physical data model is a fully-attributed data model of implementation that is dependent upon
a specific version of a database (or other data implementation option)

An architecture composed of discrete components such that the design of one component depends
only on the interface to other components, not on their internal design.

It means that it is ideally possible to replace or add one component without affecting the rest of the
system as long as the interface specification is retained.

A discrete component of the tool in the modular architecture. Conceptually, it can refer to both
functional module and software module.

A smaller piece of a discrete component of which a module consists. One functional sub-module is
functionally independent from others.

A kind of software entity to moderate the behaviour of a component even though the component
contains the different types of implementation (e.g. legacy, black box, etc) so that one can enhance
the interoperability among the modules and sub-modules.

Units for input data within the primary database are described within the database
documentation in section 10 or can be viewed via the table description within MS SQL Server
Management Studio?.

In addition, the POM (via AIMMS) has in built unit conversion and it is possible to switch easily
between units (e.g. kWh/MWh/GWh) for results reporting.

1.4. Structure of this document

The main section of the document is structured as follows:

P Section 2 describes the overarching tool architecture

Section 3 describes the database structure

4
P Section 4 describe the tool process flow and corresponding sub-module libraries
4

Section 5 describes the API (application programming interface)

2 Right click on the table -> Properties -> Extended Properties
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Section 6 provides instructions for installation and configuration
Section 7 provides an overview of the user interface (Excel and ArcGlIS)

Section 8 describes the specific Excel Ul screens

The appendices are structured as follows:

>

>
>
>

Appendix 9 describes sample use cases for different parts of the tool
Appendix 10 contains documentation for each database
Appendix 11 contains the ER (Entity Relationship) Diagrams for each database

Appendix 12 contains code documentation for each module
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2. Overarching Tool Architecture

2.1. Mapping to the Functional Specification

The original EnergyPath Networks Tool Functional Specification (Deliverable S1D1) outlined four
high-level conceptual modules, integrated via an overarching control framework:

»  Household Options Module (HOM)

P Spatial Analysis Module (SAM)

P Network Analysis Module (NAM)

»  Pathway Optimisation Module (POM)
»  Master Control Framework (MCF)

Within each of these a series of discrete sub-modules was outlined (e.g. HOM-003, SAM-005), all
controlled via the MCF, to perform the functional requirements of the tool. The technical design
of the tool (covering individual module components, individual databases, schema naming, etc)
is based on this terminology.

2.2. Software components

The following software components comprise the overall tool; the rationale for selecting each of
these, and for the overall tool design architecture is outlined in the earlier (S1D2) Design
Architecture deliverable and is not repeated here:

P Python 2.73 (64bit) — this has been used to code key functional requirements across the
HOM, SAM, NAM and MCF as well as ‘wrap’ key 3™ party software. The following
python libraries are also used:

- numpy

- pandas (includes scipy)
- SQLAIchemy

- pyodbc

- pywin32

- matplotlib

- sphinx

- numpydoc

scikit-learn

P EnergyPlus® v8.1 (64bit) - used within the HOM for dynamic building energy simulation

3 https://www.python.org/
4 http://appsl.eere.energy.gov/buildings/energyplus/
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P ETI Optimising Thermal Efficiency SAP model (modified version) — used as part of the
simplification of the building archetype representation

P ArcGIS® 10.2.2 (64bit) — used within the SAM to support the spatial analysis
requirements and spatial elements of the GUI

— This include the Network Analyst and Spatial Analyst extensions along with the
Productivity Suite

P PSS Sincal® 10.5 (32bit) — used within the NAM for steady state analysis of electricity and
heat distribution networks

- This includes the Electro and Heating modules

> AIMMS’ 4.23 (64bit) — used within the POM for generating the optimisation problem
- This includes the CPLEX 12.6.3 solver

P> @Risk® 6.2 — used via the Excel GUI for generation the Monte Carlo simulated inputs

P Microsoft Excel® 2010 (32bit) or above which is used as the main GUI (along with ArcGIS)
- Itis also used to manage @Risk (via VBA) as this is an Excel plug-in)

P Microsoft SQL Server’® Commercial 2008 R2 (64bit) and management studio

— For all databases with the exception of ArcGIS which uses its own geodatabase
format to store spatial information (relevant attribute data required from this is
still stored within the MSSQL databases)

2.3. Design architecture

An overview of the technical design architecture is shown in the figure below. This highlights the
four main sub-modules, the MCF and main Ul, location of third party tools and primary /
secondary databases. It also illustrates the high level control and data flow interactions between
them.

An Excel Ul is used to enter and interrogate data and results as well as indirectly execute the
process steps within the tool. The ArcGIS Ul is also used to support the input of spatial data and
visualization of interim and final spatial results.

5 http://www.esri.com/software/arcgis/arcgis-for-desktop

6 http://w3.siemens.com/smartgrid/global/en/products-systems-solutions/software-solutions/planning-
data-management-software/planning-simulation/pages/pss-sincal.aspx

7 http://www.aimms.com/

8 http://www.palisade.com/risk/

% http://products.office.com/en-us/excel

10 http://www.microsoft.com/en-gb/server-cloud/products/sql-server/
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Figure 2-1 Overview of technical design architecture
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The architecture reflects a highly modular structure with a hybrid centralised / decentralised DB
configuration, supported by the MCF orchestrator. As outlined in the original (S1D2) Design
Architecture deliverable this helps to:

P Enable flexible, parallel development across the tool

P Isolate 3™-party components and the main Ul so that they are easier to update or
replace in future, if needed

P Centralise the management of primary input and results data to facilitate an audit trail

- The secondary databases only store intermediate calculation data which is
needed across other (sub)-modules

» A main Ul which is decoupled from the core tool (with the exception of @Risk), which
means that it is easier to move to a separate Ul platform at a later date, if required

2.4. |IT infrastructure

2.4.1. Operating system

A 64bit Windows operating system architecture is required for compatibility with all 3rd party
software within the tool and due to memory requirements within particular sub-modules. 64bit
operating systems overcome the memory limit of 4GB seen in 32bit operating systems. A single
POM optimization problem typically requires >>4GB of memory.
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2.4.2. Hardware

The tool has been designed to work on a dedicated, sufficiently powerful desktop computer.
With some adaptation (and subject to licensing requirements for the third party software) it
would be possible to adapt this to a cloud-based environment.

2.4.3. Parallel computing

From EPN R1.0 onwards the tool has been designed to enable parallel computing of simulations
within the POM module — across multiple machines. In a simple two machine example this is
enabled by a master control machine (1) controlling the execution of the POM on both machine
(1) as normally and temporarily calling machine (2). The POM secondary database is stored on
machine (1) only, but the POM AIMMS model on both machine (1) and (2) connect directly to it.
This is illustrated in the figure below. It requires that both machines are able to connect to the
same SQL Server Instance to access the POM database.

Figure 2-2 Overview of architecture for POM parallel computing

(Master) Machine 1 Machine 2

E Plus Weatherfil
gy teaneie ArcGIS Geodatabase SINCAL (Temp) DBs
SAP model (Temp) DB

HOM

MCF A
Main Ul

Secondary MSSQL DBs

<--¥ Control Flows
<—» Data Flows

Hence machine (2) only acts as a temporary processor for the optimization and returns the
completed results directly to the master machine (1). In this manner if 100 simulations are
required 1-50 can be sent to run within machine (1) as normal and 51-100 can be sent in parallel
to machine (2). Further machines (subject to available hardware and software licenses for the
POM) can be added relatively easily within this configuration.

2.5. Technical configuration of 3" Party Tools

Installation and initial configuration of the EnergyPath Networks Tool (including 3™ party
software) is described in section 6. Global configuration parameter values and settings for
various parts of the tool (including commercial third party packages) are stored and described in
the following primary database tables, as it is necessary to store these as part of an audit trail to
be able to recreate a set of results:

»  Mcf.pi_GlobalParameters
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P Mcf.si_POMGlobalParameters
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3. Database Structure

The primary MSSQL database, subject to two key exceptions!?, stores all

»  Primary input data necessary to run the tool

» Intermediate output calculations from one module which are necessary for another, the
key example being all outputs generated by the HOM / SAM / NAM necessary to run the
pathway optimisation process in the POM

P Pathway results from the POM

As part of the modular design, the secondary databases are effectively transient, containing only
the data necessary to generate the intermediate output calculations which are passed to other
modules.

However, to create these intermediate outputs each of the HOM / SAM / NAM modules (in
reality containing a series of sub-modules) and corresponding secondary databases will require
input information, which is pushed by the MCF from the primary to the secondary database.

Each secondary database may also store transitional calculations for use between sub-modules
in the same overarching module. These calculations only serve to support the calculation of the
final intermediate outputs from a module and hence are not pulled back from the secondary
database to the primary database in the same manner as intermediate output calculations.

The modularity of the tool is reflected within the physical data model via a combination of
specific database schema (i.e. to compartmentalise related sets of data tables, or views/stored
procedures) and a clear naming convention. This is important to navigate the large number of
tables required across the entire tool.

A summary of the database structure and an illustrative example is provided below. The full set
of tables for each primary and secondary database (including descriptions) and their Entity
Relationship diagrams (from the primary and foreign key structure) are described in more detail
in sections 10 and 11, respectively.

11 The EnergyPlus Weatherfile (EPW) and additional spatial data necessary for displaying ArcGIS layers,
which is stored in a native ArcGIS geodatabase format.

ETI SSHP — EnergyPath Networks — Technical Design and User Guide 14/118

Baringa Partners LLP is a Limited Liability Partnership registered in England and Wales with registration number 0C303471 and with registered offices at 3rd Floor, Dominican Court, 17 Hatfields, London SE1 8DJ UK.




¥ Baringa

Table 3-1 Database naming convention and structure

Table / view / Stored

Database Schema Description Description

procedure prefix

Primary mcf Relevant for >1 module si_ Table containing a set of user defined input elements e.g. all time periods
contained within the tool. These are used to maintain data consistency.

These are pushed into ‘mirror tables’ within the relevant secondary database
(based on the schema). E.g. a hom.si_XXXX table contains set information only
relevant to the HOM module.

hom Relevant to HOM secondary DB only sg_ Table containing a set of elements generated by a process within a tool module
(e.g. the set of final network technologies generated within the NAM to be used
in the POM). These are pulled back from a secondary DB into the primary DB

These are used to maintain data consistency.

sam Relevant to SAM secondary DB only pi_ Parameter table containing user defined input data. E.g. the capex costs of
individual network components.

These are pushed into ‘mirror tables” within the relevant secondary database
(based on the schema). E.g. a hom.pi_XXXX table contains parameter data only
relevant to the HOM module.

nam Relevant to NAM secondary DB only pc_ Parameter table containing data calculated by one module and pulled back to
the primary database for use in another. E.g. the cost and losses for the final
network technology options from the NAM for use in the POM.

These are pulled back from the secondary DB (from a mirrored po_ table) to the

primary DB
pom Relevant to POM secondary DB only r_ These contain results generated by the POM which are pulled back to the
primary DB
prepom Used as part of pre-processing vs_ (resp. sg_, vp_, pc_) These are views used to create sets of elements (resp. intermediate calculated
calculations for POM secondary DB sets, final calculated parameters or intermediate calculated parameters),

primarily as part of the pre-processing to generate data for the POM
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monte_carlo Used as part of calculating simulated Vp_ These are views used to create data parameters, primarily as part of the POM
input parameters used across tool pre-processing
- - sp_ This is a stored procedure used to create data parameters as part of the POM

pre-processing

Prehom /
presam /
prenam

Intermediate pre-processing to create
input data for HOM / SAM / NAM
modules

pc_ (resp vp_, sg_, vr_)

Table containing an intermediate calculated parameters e.g. domestic buildings’
demands (resp. final calculated parameters, calculated set of elements,
calculated parameters for results review) contained within the tool. These are
pushed from the primary DB into the equivalent secondary DB tables for use in
the relevant sub-modules

vp_/vr

Intermediate views used to support the processing of results into the required
output format for the Ul or to be processed for display in ArcGIS

Secondary

000

Tables relevant to >1 sub-module within
a single secondary database

Sg_

Table containing a set of elements generated by a process within the tool
module (e.g. the set of final network technologies generated within the NAM to
be used in the POM). These are pulled back from the secondary DB into a
mirrored table in the primary DB

001 to 00X

Tables related to a specific sub-module
within the secondary database

pi_

Table containing a set of user defined data parameters contained within the
tool. These are pushed from the primary DB into the equivalent secondary DB
tables for use in the relevant sub-modules

po_

Parameter table containing data calculated by one module and pulled back to
the primary database for use in another. These are pulled back from the
secondary DB to (a mirrored pc_ table) the primary DB

pc_

These are parameter tables containing data calculated by one sub-module, for
use by another sub-module in the same overall module. le they only exist in the
secondary DB and are not pulled back into the primary DB

The equivalent of data parameter for use in the POM, generated as part of the
pom-preprocessing

Secondary —
POM only

Inputs

All input data necessary to perform the
pathway optimisation

The equivalent of a set for use in the POM, generated as part of the pom-
preprocessing
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Results

All results generated and saved from the
pathway optimisation process

va_

A view used to create supplementary input data necessary for use in the POM
after the pre-processing has transferred data from the primary DB into the POM
secondary DB

v_/p_

A user defined results variable / parameter in the POM (AIMMS model) which is
exported and saved in the POM secondary database. It is then pulled back to
the primary DB via the views below

vr_

Intermediate view to process the results of the optimiser in the POM (AIMMS
model) which are exported and saved into the primary DB in an r_table
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An illustration of the data transfer between tables and schema structure / naming convention is
provided in the table below.

Figure 3-1 lllustration of database naming convention

HOM module and secondary DB SAM module and secondary DB

Sub-module 007 schema Sub-module 002 schema Sub-module 007 schema

Primary DB

3.1. Management of multiple scenarios in data structure

From EPN R2.0 onwards the underlying data structure of the tool has been extended to capture
input and processed data associated with multiple scenarios/sensitivities in a number of key
areas across the HOM/NAM/SAM. These have been targeted initially to a small number of areas
which can take substantial time to configure or process, thus allowing the user to undertake
these steps across multiple scenarios in a batch and switch between the resulting data for use in
the POM. The data structure has also been configured to allow storage of multiple sets of
results from the POM in the primary database.

Implementation of multiple scenarios has been included for:

P Target temperature profiles as an input to EnergyPlus (HOM-003), which in turn impacts
archetypes heat demand used in SAM, NAM and POM

P Cluster and inter cluster connection definitions (SAM-007/8), which will then be used in
the NAM (network and transmission options and cost curves) and POM

»  Non-domestic buildings demand (NAM-001, SAM-007, POM-001)Pathway Archetype
cluster constraints (SAM-007, POM-001)

A distinction is made between databases - and corresponding sub-modules - which contain a full
set of scenario-related data (i.e. tracking all scenarios simultaneously) and those, which are
effectively agnostic (i.e. they are passed a sequential set of scenario data as a batch process, but
have no knowledge of which scenario is active, as this is controlled remotely by the MCF):
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»  The MCF / primary database and the SAM contain information across the active set of
scenarios in parallel*? (this is necessary in the SAM to be able to compare multiple

cluster definitions in ArcGIS)

»  The HOM, NAM, POM modules and secondary databases are agnostic and contain only

the scenario data passed by the MCF

Figure 3-2 lllustration of multi-scenario data management

»  Multiple scenarios management
Proposed architecture

Primary DB (outputs from modules)

geduceddlz;chetypes Clusters (F) Network & lransgli\s;é:;{l

eman " cost curves i.e.
Connections (F) : 1

Storage tank & zone FOM, VOM, capacity (A)

temperature profiles Cluster.map :H. Network & transmission
(4) Cluster constraints (F) input factors (A)

Primary DB (inputs from modules)

NDB & Archetypes demand (D) —
SAM-4 & SAM.7 (NDB only) Clusters (A)
Cluster map (A)

Target temperature Clusters (F) - SAM-7 Cluster constraints {A)
profiles (A) gg‘;‘;’ & polygon labels (F) - Cluster connections (A)
) NDB (D) and archetype

Network & connection metrics (F)
_SAMS demand (A)

Views are used to pass data from the primary
DB to secondary DBs and back.

¥ Baringa

All POM
results (A)

Cluster map &
connections (A)
Cluster constraints (A)
NDB & archetype
demand + simulations
(A)

A: Active scenario
D: Default scenario
F: Full set of scenarios

12 An exception is made for data items for which this is not appropriate and which therefore use data

associated with ‘default scenario’.
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4. Tool process flow and sub-module libraries

Each module (HOM, SAM, NAM, POM) contains one or more sub-modules (HOM-001, SAM-005,
etc), which reflect discrete, coded libraries. This naming convention links back to the original
Functional Specification and, as described above, is reflected in the database structure and
naming convention.

In addition to this there are three further parts of the tool, which can effectively be considered
as self-contained ‘libraries’:

»  The MCF to control the process execution flow across the entire tool
P The Excel Ul to facilitate the read/write of input/results from and to the primary DB
P The Excel Ul to facilitate the generation of the Monte Carlo simulated inputs

The interaction between sub-modules is outlined in the diagram and a summary of each is
provided in the table below. More detailed documentation for each library is provided in section
12.
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Figure 4-1 Overview of functional sub-modules
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Table 4-1

Functional sub-modaule libraries
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Module Name Functional Description Framew

Start

Initialise Primary Database

Creates the IDs associated with the master set of Base Archetypes (accounting for the
user-defined active heating systems), initialises boundary conditions from ESME

HOM

HOM-000

Household Options Module
(initialisation)

Transfers the relevant set of data from the PDB to the HOM secondary DB.

MCF

HOM-001

Base archetype SAP parameterisation
(SAP Model)

Calculates the extended set of SAP inputted variables for Base Archetypes representing
buildings identified in SAM-002 (excluding heating) and passes these to the wrapped ETI
SAP model to calculate the set of required inputs for HOM-002 (heat loss rate, thermal
mass)

Python + ETI SAP
Model

HOM-002

Base archetype (non-spatial) clustering

Mathematically clusters (using a k-means based algorithm) the Base Archetypes using
the subset of SAP inputted data and floor area to a smaller, more manageable number,
which share similar energy performance characteristics. This creates a set of Reduced
Archetypes. The number of clusters within floor area band groups (i.e. reduced
archetype energy states) is defined by the user.

Python

HOM-003

Domestic dynamic building energy
simulation

This simulates the operational profile of each Reduced Archetype with different types of
heating system and provides the final energy demand profile(s) (>1 where there is
optionality related to storage or micro-CHP) associated with meeting space heat and hot
water storage requirements. Uses multi-core processing for improved performance.

Python + EnergyPlus

HOM-004

Pathway Archetypes (costs and
profiles)

This module creates the expanded set of Pathway Archetypes which represent the
(costed) possible transitions for the domestic stock from the base year to the final
pathway year accounting for changes in heating systems and insulation packages (and
their associated costs) as well as building and cluster level constraints where applicable.
These reflect choices that can be made by the POM. The process for creating these
draws on information from the Reduced Archetype definition to make the total number
of pathways more manageable. The pathway archetype represents transition of final
archetypes i.e. reduced archetypes that have similar costs hence representing group of
base archetypes with similar energy and transition cost. The cost is calculated for each
cluster based on the relevant stock of base archetypes represented by the pathway
archetype. Uses multi-core processing for improved performance.

Python

SAM

SAM-000

Spatial Analysis Module (initialisation)

Transfers the relevant set of input data from the PDB to the SAM secondary DB.

MCF

SAM-001

Map existing topology and export

This sub-module maps the key existing and future planned spatial elements in the LA
including buildings, road topology, electricity and heat network component sizing, PV
and EV uptake. It allows the user to define at a unit level the location of planned or

ArcGIS
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potential new build energy system features (e.g. the location of a new build housing
estate or a polygon package for network-connected supply technologies)

SAM-002

Domestic building archetype matching

This sub-module defines the building-level attributes for all domestic dwellings at
address level, and matches each individual building with one of the Base Archetypes
defined in HOM-000. The user can also define known building attributes at address level
or en-masse using spatial ArcGIS layers, which are then factored into the building
matching algorithm. This matching uses external data sources e.g. Geolnformation,
Xoserve data to define key attributes at an address level, while more aggregated
datasets at GOR level are then used to statistically assign remaining attributes to each
address.

Python

SAM-003

Non-Domestic building archetype
matching

This sub-module defines the activity class and floor area for non-domestic buildings at
address level. The activity class is based on the OS basefunction, Scat code or other
external address level data source. The user can also define the relevant basefunction or
ScatCode directly in the OS buildings layer, where these are known.

Python

SAM-004

Electricity Network topology synthesis

This sub-module synthesises an electricity network topology for the LA — for use in the
load flow modelling and costing by NAM.. It utilises data on building location, road
network topology and DNO data on the locations of existing substations. The synthesis is
based on connecting each address to its nearest substation while following the road
network. The user also has the ability to define network connectivity data, where
available, including: full network topology (connection of each address/LV substation to
its upstream LV/HV substation via LV/HV feeder), HV network only (connection of each
LV substation to its upstream HV substation via HV feeder) and partial LV network (LV
addresses that are served by LV substations located within their buildings), It also
provides topology information relevant to NAM-007 such as the total length of roads on
gas grid.

ArcGIS + Python

SAM-005

Package and existing network
processing

This function exports user defined data to the PDB related to the location of the defined
polygon packages and known existing network features of the synthesised network
topology (i.e. size of heat pipes and LV/HV feeder links)

ArcGlIS + Python

SAM-006

Cluster input layer creation

This sub-module provides the user with the input layers on the electricity network
topology showing the network connectivity at LV feeder, LV substation, HV feeder and
HV substation levels. This, along with the layer showing auto generated cluster
definition by NAM, provides all of the information layers in ArcGIS to inform the user
defined clustering process in SAM-007.

ArcGIS + Python

SAM-007

Process (manual / auto) cluster
definition and Non-domestic pathway
costing

This sub-module allows the user to define clusters to spatially aggregate the local area.
A number of different approaches are available to define the clusters (manual, semi-
automated, automated) along with different information layers reflecting electricity
network topology information. The user can define spatially contiguous clusters for: LV
feeder(s) and downstream, LV substation(s) and downstream, HV feeder(s) and
downstream and HV substation(s) and downstream. The user defined cluster definitions

ArcGlIS + Python
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are then checked for meeting rules around inclusion of spatially contiguous elements of
electricity network and the results are displayed as an ArcGIS layer. This layer gives
feedback validating the clusters that meet the network rules and giving simple
instructions to modify the cluster where these rules are broken. Following creation of
the clusters, post-processing maps all energy system features to each cluster for use in
subsequent NAM and POM sub-modules.

This module also defines potential pathways for heating system transition in the non-
domestic buildings and the annual cost for these pathways. The user is required to
define the starting option and the potential options available for each activity class as
well as the cost banding. The non-domestic buildings are then grouped based on cluster,
similar option transitions, cost banding and demand banding.

SAM-008

Inter-cluster connection definition

Once the clusters have been defined in SAM-007 the existing and potential inter-cluster
connections for heat, gas and hydrogen are defined by the user. Electricity network
meshing connections can also be defined by the user between any two nodes at the
LV/HV level. The resulting data is processed for use in the NAM and POM sub-modules

ArcGIS + Python

SAM-009

ArcGlIS spatial results

This function takes the cluster-level POM results (which have been pushed to the
primary DB after POM-002) and automatically creates a series of layers within ArcGIS to
view the spatial results.

ArcGIS + Python

NAM

NAM-000

Network Analysis Module
(initialisation)

Transfers the relevant set of input data from the PDB to the NAM secondary DB.

MCF

NAM-001

Electricity feeder cost metrics
(optional)

This sub-module prepares the underlying nodal representation of the electricity network
and associated data (e.g. length of links, location of demand points, etc) using data from
SAM-004. It then calculates a normalised reinforcement cost metric for each individual
LV feeder via calculation of allowable load through SINCAL. It also provides a database
of viable reinforcement options that are parameterised into more aggregate options in
NAM-007.

Python + VBS + PSS
Sincal

NAM-002

Auto-cluster definition (optional)

This optional sub-module undertakes a series of tests involving different ‘cluster’ shapes
(of different sizes) and calculates a series of metrics for heat and electricity networks,
which are then compared against defined thresholds. The end result is a set of
suggested cluster definitions which respects the underlying electricity network topology,
but which allows for a “good” representation of both heat and electricity cost functions
within the same cluster, when these are calculated from the other NAM sub-modules.
These suggested cluster shapes can be used by the user as part of SAM-007.

Python + VBS + PSS
Sincal

NAM-003

Electricity Network (HV) options and
load flow modelling

This sub-module prepares the underlying nodal representation of the electricity network
and associated data (e.g. length of links, location of demand points, etc) using data from
SAM-004. It then generates a series of pre-defined network reinforcement options to
be tested by the operational analysis tool (PSS SINCAL) for the HV network. It then
assesses the allowable capacity limits, associated with each reinforcement
configuration, subject to overarching constraints (e.g. on voltage) and the base costs

Python + VBS + PSS
Sincal
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associated with each option. It also provides a database of viable reinforcement options
that are parameterised into more aggregate options in NAM-007.

NAM-004

Heat network topology synthesis

This uses ArcGIS functionality to generate synthesised network topology information for
the Heat Network (as per fully automated synthesis for electricity in SAM-004), but with
an independent distribution heat network for each cluster as defined via SAM-007. As
part of this process it also calculates the estimated heat load weighted centre for the
cluster.

ArcGIS + Python

NAM-005

Heat Network options and load flow
modelling

As per NAM-003 this prepares the underlying nodal representation of the heat network
and associated data for use in PSS SINCAL using data from NAM-004. It then generates a
series of pre-defined network reinforcement options to be tested by the operational
analysis tool (PSS SINCAL) at a cluster (and inter-cluster) level. It then assesses the
allowable capacity limits, associated with each reinforcement configuration, subject to
overarching constraints (e.g. maximum pressures) and the base costs associated with
each option. It also provides a database of viable reinforcement options that are
parameterised into more aggregate options in NAM-007.

Python + VBS + PSS
Sincal

NAM-006

Gas/H2 options

This creates a simplified set of Gas/H2 operation, extension, conversion or
decommissioning options at cluster and inter-cluster level.

Python

NAM-007

Cluster network option cost functions

This sub-module consolidates the more detailed reinforcement and new build options
from NAM-003/5/6. For electricity it first consolidates these at the cluster level and
then creates a parameterised set of simpler options for use in the POM (including
capacity, cost, losses and other data). For heat networks the base cost functions are
already at cluster level, but the simplification process is then applied.

Python

POM

POM-000

POM Data Pre-Processing and
simplification

Views and stored procedures within the primary database (within the prepom schemas)
contain the logic to automatically generate the full set of required POM inputs from
other primary DB tables (which have themselves been generated as outputs from the
HOM, SAM and NAM sub-modules). The pre-processing also includes aggregation logic
for timeperiods and timeslices and handling of demand diversity (through exogenous
scaling factors).

MCF

POM-001

Pathway optimisation process

This solves a large number of Mixed-Integer Programming (MIP) problems generated by
POM-001 to obtain a least-cost solution (within a user defined tolerance threshold). A
branch & cut algorithm is used which creates a tree of LP sub-problems for each
combination of the integer variables. The algorithm can prune sub-branches when it
realizes a feasible solution won’t be found there or the currently found solution is better
than what can be found exploring the pruned sub-branch.

AIMMS + CPLEX solver

POM-002

Export POM results

This function pushes the POM results back into the PDB so that they can be viewed
within the Excel Ul, or via the ArcGIS visualisation process in SAM-009

MCF
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OTHER MCF-001

Master Control Framework

This is responsible for managing the overall process execution flow for the entire tool
including, transfer of data between primary and secondary databases, and execution of
each sub-module, data validation checking and progress logging.

Python

EUI-001

Excel Ul pathway results

This undertakes two main functions.

- Itallows the user to read/write/update input and results data to/from the primary
database (no direct user interaction is required with the secondary databases),
outside of input data defined through the ArcGIS Ul via the SAM sub-modules.

- It also allows the user to initiate the process execution within the MCF / Monte
Carlo input generation.

Excel + VBA

MCG-001

Monte Carlo input generation

Whilst this is technically contained within the Excel Ul it is designed as an isolated
process, which reads from a number of primary DB input tables and generates a series
of Monte Carlo simulated inputs, which are written back to the primary DB for use
elsewhere in the tool. All Monte Carlo simulated inputs are used directly within the
POM-001 process, with two exceptions.

- Simulated insulation U-value parameters which are required as an input to the SAP
parameterisation in HOM-001

- NDB retrofitting cost as calculated in SAM-007

Excel + VBA + @RIsk
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4.1. Basic end-to-end process flow

The overall process flow across the tool is shown above in Figure 4-1 (each of the sub-modules
are then described in Table 4-1). The execution of the tool is managed through the [Process
Flow] sub-menu screen as described in section 8.4.1, which mirrors the above diagram.

The diamonds in the process flow diagram are key points of user input (outside of all other data
which it is assumed has been entered appropriately by the user in the primary database prior to
execution). If the user updates these particular points it is then necessary re-run all
‘downstream’ sub-modules that will be affected by these changes as outlined in the process flow
diagram.

The key points of user input cover:

»  Define active heating system combinations — which is used to limit the possible (valid)
combinations of primary heating / secondary heating / storage technology /heating
controls (within HOM-000), active within the overall tool to manage complexity

- This is updated via the hom.si_ActiveHeatingSystemCombinations table
accessed under Ul sub-menu [HOM] -> [Pathway Archetype Configuration]

P Define potential non-domestic options at activity class level and their valid transitions —
which is used to limit the possible (valid) heating system and insulation package
transitions (within SAM-007), active within the overall tool to manage complexity

This is updated via the mcf.pi_ NDB_ActivityClassRetrofittingOptionsMap and
mcf.pi_NDB_ValidRetrofittingOptionTransitions tables

»  Define temporal aggregation — which is used to simplify the complexity of the POM
optimisation (via the pre-processing in POM-000) with respect to time/buildperiods,
characteristic days and diurnal timeslices. It is also used to limit the number of
buildperiod vintages, which are assessed within EnergyPlus (HOM-005) and to
streamline the number of final network cost functions produced by NAM-007

- This is updated via the following tables accessed under Ul sub-menu [MCF] ->
[Temporal configuration]

- mcf.si_FinalTimePeriods / mcf.si_FinalBuildYears
- mcf .si_FinalDiurnalTimeSlices / mcf .pi_DiurnalTimeSlicesMap /
- mcf .si_FinalCharacteristicDays / mcf .pi_CharacteristicDaysMap

» Define the number of sets of Monte Carlo simulated inputs used within the POM
optimisation. The majority of simulated inputs are used directly at the POM pre-
processing stage (POM-000). However, simulated insulation performance is an input to
the SAP parameterisation of the Base Archetypes (HOM-001)

- This is updated via the Ul sub-menu [Simulate] -> [Simulation Manager]

P ArcGIS steps [A to 1], which are described further in section 9
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Multi-scenario data management

As described in section 3.1 multi-scenario data management is focused on a number of discrete
parts of the tool such as target temperature profiles for use in EnergyPlus. The user interacts
with the multi-scenario data management via 3 areas:

>

Input data configuration: the mcf.si_Scenarios table (accessible through the Excel Ul as
per all other input tables) is used to define the number of scenarios and whether they
are considered to be ‘active’ (i.e. the data should be processed) when running the tool.
Related input tables (e.g. hom.pi_TargetComfortTemperature,
mcf.pi_NDB_EnergyBenchmarks and mcf.sg_clusters) have an additional column for
“scenario” such that data can be entered against the multiple defined scenario names

Process execution: the [Process Flow] screen described in 8.4.1 allows the user to run
the tool for both the “default scenario” or automatically batch process a number of
steps, cycling through the data for all scenarios which are defined as ‘active’

Results: the results tables returned from the POM to the Primary database have a
scenario index (for both the default and other active scenarios which have been run)
which can be used to compare results across the scenarios in the standard Excel Ul (see
section 8.5.1). To be clear, the POM processes a single scenario at a time (like the HOM
& NAM) but appends the relevant scenario name to the results tables being returned.

In addition, the spatial results layers which are generated for ArcGIS automatically in
SAM-009 produce results for all active scenarios.

ETI SSHP — EnergyPath Networks — Technical Design and User Guide 28/118

Baringa Partners LLP is a Limited Liability Partnership registered in England and Wales with registration number 0C303471 and with registered offices at 3rd Floor, Dominican Court, 17 Hatfields, London SE1 8DJ UK.




¥% Baringa

5. API Specification

5.1. Overview

This section provides an overview of the API design specification for the tool, the detailed
description of each individual API (e.g. purpose and arguments) are catalogued as part of the
code documentation in section 12.

The APl within the MCF (api.py) has been defined in a flexible manner, given the modularity of
the underlying tool. A central APl has been defined as:

epdt.pro.RunProcess(‘Database Name’, ‘schema’, ‘ProcessName’)

This is designed to execute a call based on argument information defined in the primary
database mcf.pi_ProcessDefinition table. The information within this table provides information
specific to the execution of each (sub)-module API. This way the MCF has the ability to execute
(in the appropriate defined sequence) every sub-module API that has been ‘exposed’ in its code
to the MCF layer.

As part of this epdt.pro.RunProcess() can be used to indirectly pass arguments specific to each
sub-module API, via information that the user has defined in the mcf.pi_ProcessDefinition table -
i.e. the MCF can access the full functionality of exposed APIs. Where this is blank each sub-
module uses its own default argument(s), in most cases this is simply ‘execute’ the entire sub-
module process.

The choice of sub-module APl exposed directly to the MCF layer is a trade-off in complexity of
defining the appropriate process execution flow and the degree of fine control. Where a process
is fast it is generally sufficient to define the API to execute the entire process only. Therefore we
have tended to focus exposure at the MCF layer on key processes that a) repeat a cycle of logic
with b) significant overall execution time.

For example, the operation of EnergyPlus may require the simulation of between 10% to 10°
different building simulations (or “Reduced Archetypes”), which is a time consuming process.
During a single batch run some of these may ‘fail’ due to e.g. input data errors, whilst the
majority may complete ‘successfully’. Once the input data for the failed simulations is fixed it
would preferable to re-execute only these via the MCF rather than having to repeat the full set.

5.2. MCF APl example

The example below assumes an illustrative subset of the mcf.pi_ProcessDefinition table as
below.

Process | Task Module Process Step Task Execute | Function Name Function
ID Seq Name Arguments
1 1 HOM

Call RunEPAIl | Call RunEPAIl | Function | 1 epdt.hom.api.computeEPlus
call

2 1 HOM Call Call Function | 1 epdt.hom.api.computeEPlus | by_ID,
RunEPSubset | RunEPSubset | call RA002
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Within the MCF api.py, executing the API as either of
epdt.pro.RunProcess (PDB, 'mcf', 'Call RunEPAll"'")

epdt.pro.RunProcess (PDB, 'mcf', 'Call RunEPSubset')

Indirectly executes the EnergyPlus sub-module APl epdt.hom.main.computeEPlus() using the
information from row 1 or 2, respectively, from the mcf.pi_ProcessDefinition table.

Passing no argument to epdt.hom.main.computeEPlus(), as per 'Call RunEPAII' automatically
runs all reduced Archetypes in EnergyPlus whereas the ‘Call RunEPSubset’ equivalent effectively
executes the API as:

epdt.hom.main.computeHOM (by_ID, RA002)

l.e. instructing EnergyPlus to run one Reduced Archetype only.
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6. Installation and configuration

6.1. Underlying software installation

The following sections outline the installation of the software. For 3™-Party software packages
we only describe steps, which are additional or different from the default installation process. It
is recommended that all software is installed onto the same drive e.g. C:

The core tool files and databases are provided within an EDPT.ZIP file (or equivalently pulled
from the Assembla GitHub repository), the instructions assume that this is unzipped to a folder
labelled C:\EDPT.

6.1.1. Overarching pre-requisites
The following are overarching pre-requisites for the EPN tool

»  Software

- A 64bit version of Windows — EPN has only been tested to-date with Windows 7
Enterprise and Professional 64bit editions

- MS SQL Server Express 2008 R2 or MS SQL Server Commercial as outlined in
section 6.1.3, as this has been selected to be cross-compatible with all relevant
EPN third party components

- ArcGIS for Desktop requires Microsoft .NET Framework Version 3.5 SP1%3 to be
installed first

- Notepad++ v7.3.1is not required, but is useful for viewing text based files (e.g.
* log, *.ini, *.py etc)

» Hardware

— Database storage is the main factor in relation to the size of the EPN tool, it is
recommended that a minimum of 50 GB of space is set aside for the tool itself
(in addition to space required by the underlying software)

- Memory — whilst 64bit operating systems allow use of the disk page file to
extend the available system memory this is significantly slower than relying on
system memory. In the overall tool process flow (see section 4.1) the AIMMS
optimisation model (POM-002) and a number of EPN sub-modules that have
been configured to run in parallel across multiple CPU cores (e.g. HOM-005 and
HOM-006) are the key drivers of high memory use. 32GB+ of physical memory
is strongly recommended. Windows 7 Pro has a constraint of 192GB of
accessible memory, Windows 10 Pro allows 2TB and Windows Server 2012
allows 4TB.

— A fast multi-core processor is strongly recommended given the intensive and
parallelised processes identified above (AIMMS can already use multiple cores

13 http://www.microsoft.com/en-gb/download/details.aspx?id=22
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for a single optimisation process). The development machine for EPN was
based on an Intel Xeon 3.1 GHz processor with 32 cores

6.1.2. Python

Python 2.7** (64bit) has been used to code key functional requirements across the HOM, SAM,
NAM and MCF as well as ‘wrap’ key 3™ party software. To facilitate installation and
management of python we use Miniconda 64bit for Python 2.7

from http://conda.pydata.org/miniconda.html

—— — 5
& Miniconda 3.5.2 (64-bit) Setup =) -S| |5 Miniconda 3.5.2 (64-bit) Setup 23|

. S IS Select Installation Type
Welcome to the Miniconda 3. 5.2 SR TURRAEA MW  Fiease select the type of installation you would like to perform for
(64-bit) Setup Wizard Miniconda 3.5.2 (64-bit).

This wizard will guide you through the installation of
Miniconda 3.5.2 (54-bit).

Install for:
Itis recommended that you dose all other applications
before starting Setup. This will make it possible to update
relevant system files without having to reboot your ) Just Me (recommended)

computer.

Click Next to continue. @ Al Users (requires admin privileges)

< Back ” '5‘Mext> ] [ Cancel

& Miniconda 3.5.2 (64-bit) Setup o s

Wele LI M Advanced Installation Options
LXFNRBEAEEM  (C,stomize how Anaconda integrates with Windows

Advanced Options

[¥] Add Anaconda to the system PATH environment variable

This ensures that PATH is set correctly when using Python, IPython,
conda, and any other program in the Anaconda distribution.

If unchecked, then you must use the Anaconda Command Prompt
(ocated in the Start Menu under “Anaconda (54-bit)’).

[ register Anaconda as the system Python 2.7

: This will allow other programs, such as Python Tools for Visual Studio
PyCharm, Wing IDE, PyDev, and MSI binary packages, to automatically
detect Anaconda as the primary Python 2.7 on the system.

<pock [ Bpnsal ] [ Cancd

Once installed the user must first (via the DOS console — select Start -> Main Console Module)
create the EDPT environment and install the relevant python libraries used by different parts of
the tool

1. Create a new environment called “epdt”, with python and pip packages:

conda create -n epdt python=2.7.11=4 pip=7.1.0=py27 1 setuptools=18.1=py27 0
wheel=0.24.0=py27 0 vs2008_runtime=9.00.30729.1=1

2. Activate the newly created environment:

1 https://www.python.org/
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activate epdt
3. Install the packages for data analysis (pandas, scikit-learn, and their dependencies):

conda install mkl=11.3.3=1 mkl-rt=11.1=p0 numpy=1.9.3=py27 3
pandas=0.16.2=np19py27 0 scipy=0.16.0=np19py27 O scikit-learn=0.16.1=np19py27 O
nose=1.3.7=py27 0 pytz=2016.4=py27 0 six=1.10.0=py27_0 python-
dateutil=2.5.3=py27 0

4. Install matplotlib and its dependencies:

conda install matplotlib=1.4.3=np19py27 1 pyqt=4.10.4=py27 1
pyparsing=2.0.3=py27 0

5. Install the packages to connect to the SQL DBs:

conda install pyodbc=3.0.7=py27 0 sqlalchemy=0.9.8=py27 0
6. Install ipython and its dependencies:

conda install ipython=3.2.1=py27 0 pyreadline=2.0=py27 0
7. Install pywin32:

conda install pywin32=219=py27 0

8. Navigate to folder location of EPDT code:

C:\epdt\MODEL\CODE
(Or similar)

9. Install EPDT python package to epdt environment
pip install -e .
10. Check EPDT code installed correctly:
pip show epdt
6.1.3. MS SQL Server

A key part of the Energy Path model is Microsoft SQL Server!> Commercial 2008 R2 (64bit) and
management studio®®. This is used for all databases with the exception of ArcGIS which uses its
own geodatabase format to store spatial information (relevant attribute data required from this
is still stored within the MSSQL databases).

15 http://www.microsoft.com/en-gb/server-cloud/products/sql-server/
16 \MS SQL Server Express 2008 R2 can be used if the size of each individual database is maintained at
<10GB and data processing is limited to a single core.
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The following instructions are compiled for Microsoft SQL Server Express edition, but are
virtually identical to Microsoft SQL Server Commercial edition. Detailed setup guidance can be
found online?”. After downloading:

1.

w

Run the installation file and select “New Installation or add features to an existing
installation”

Accept the license terms and click next

Select All components of the model to install and click next

Select ‘Named instance:’ of instance configuration and click next

5 SQL Server 2008 R2 Setup = | B

Instance Configuration

Specify the name and instance ID for the instance of SQL Server. Instance ID becomes part of the installation path.

Setup Support Rules *) Default instance

Feature Selection

® Named instance: 5QLExpress
Installation Rules
Instance Configuration
Disk Space Requirements Instance ID: SQLExpress
Server Configuration
R T Instance root directory:  C:\Program Files (x36]\Microsoft SQL Serverl B

Error Reporting
Dz i St ne Tanliods SQLServerdirector:  C:\Program Files (x86)\Microsoft SQL Sever\MSSQLLO_50.5QLExpress
Installation Progress

Complete Installed instances:

Instance Name Instance ID Features Edition Version

[ <Back ][ met> ][ conce jL{ Help

— = 1 @ lavalind

5. Change the account name of SQL Server Database Engine to “NT Authority\System” or

“NT Authority\Network” and click next

5 SO Server 2008 R2 Setup - T = | B

Server Configuration

Specify the service accounts and collation cenfiguration.

Setup Support Rules Service Accounts. | Collation

Feature Selection

Microsoft recommends that you use a separate account for each SQL Server senvice.
Installation Rules

Instance Configuration Service Account Name Password Startup Type
Disk Space Requirements SQL Server Database Engine NT AUTHORTTYANETW. . [Automatic | ~|
Server Configuration SQL Server Browser NT AUTHORITY\LOCA.. Disabled H

Databese Engine Configuration

Error Reperting -
[ Use the same account forall SOl Server scrvices |
Installation Configuration Rules

Installation Progress

Complete

{ < Back H Next > H —a H Help ‘

6. On the ‘Database Engine Configuration’ screen ensure ‘Windows authentication mode’ is

selected.

17 http://blogs.msdn.com/b/petersad/archive/2009/11/13/how-to-install-sgl-server-2008-r2-express-

edition-november-ctp.aspx
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7. Complete the setup with the remaining default options. You may need to reboot your
computer to complete the installationz.

Once the default installation is complete the following settings must be changed through the
management studio

»  Server properties -> security -> server authentication
- Apply SQL server and windows authentication mode
P Under security create a new login “epdtadmin” with password “Epdt1234”
- This is used to allow the MCF to connect to all attached databases
»  Server properties -> Advanced
- Set the Maximum Degree of Parallelism to 82 (for improving performance)

The EDPT.ZIP contains a set of DB files (.mdf and ./df) which should be attached to the server
instance (see section 9.13.1 for further information on how to undertake this process):

»  EPDT-Primary_vX.X.X
EPDT-HOM_vX.X.X
EPDT-SAM_vX.X.X
EPDT-NAM_vX.X.X
EPDT-POM_vX.X.X
SINCAL_ELEC_SQLSERV
SINCAL_HEAT_SQLSERV
» ETI-TE

One further temporary SINCAL_DATABASE DB is created and attached via the initial SINCAL
setup, described in section 6.1.9.

vV vVvyVvyyvwyy

6.1.4. AIMMS

AIMMS? 4.23 (64bit) is used within the POM for generating the optimisation problem. This
includes the CPLEX 12.6.3 solver. However, POM should also work with any other versions after
AIMMS 4.0.

AIMMS has discontinued issuing USB dongle AIMMS license. However, if you are still using an
USB dongle AIMMS license, the Sentinel System Driver needs to be installed first. During the
installation process, users should select custom setup type and disable parallel driver as shown
below.

18 This depends on the machine configuration. This setting applies for a machine with 32 cores and ~200Gb
of RAM.
19 http://www.aimms.com/
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'S
) Sentinel System Driver Installer 7.5.0 - InstallShield Wizard

Setup Type s ! i ¢

Choose the setup type that best sits your needs.

Please select a setup type.
) Complete

© Custom

|

All program features will be installed. (Requires the mast disk.
space.)

Choose which program features you want installed and where they
will be installed. Recommended for advanced users.

Installshield

M 4] Sentinel System Driver Installer 7.5.0 - InstallShield Wizard

(| <Back | MNexts Cancel

] (

Custom Setup -

Select the program features you want installed.

Click on an icon in the list below to change how & feature is installed.

Feature Desaiption
Install this driver for use with the
9 -] USB System Driver Sentinel SuperPra or Sentinel

=M |Parale Oriver UltraPro tokens.
53 This feature will be installed on local hard drive.

(=28 This feature, and all subfeatures, will be installed on local hard drive.

=] Q‘I Sentinel System Drivers

This feature will not be available.

Install to:

InstallShield

< Back ][ Next > Cancel

) [

Space

AIMMS offers several types of licenses. Below gives the details setting up single-user personal
nodelock license. Full installation instructions for other types of licenses can be found here?.

1. AIMMS 4.x is now installation-free. When you start up AIMMS 4.x for the first time, AIMMS
will open the License Configuration dialog box below:

License Configuration B2
Default  License Protection Status Property Value fa
20 001001134001kc  Nodelock Active [Used by this session] License Number 001.001.134.001

Lcense Type ADMMS - Development
Start Date Jul 1, 2013
Ucense Expration Date hor 26,2018
Maintenance ExprationDate Dec 31, 2014
AR No
Aoned sovers "
conoet
PATH
MINOS, (2 sessions)
< ", ) MOSEX (Ful), (2 sessio|
e SNOPT, (2 sessons)
[F———
[ acvate... Move Up.
e
CPLEX (Ful, (2 sessior ~
m v
(o J[Ccamcel J[ oy J[ b |

2. Click Install License if you have received a valid license and the associated activation code.
Select “Install a Single User AIMMS License” and click Next.

,

iy

What do you want to do?

nstall a Single User ATWMS Licensel
(7 Connect to the AIMMS License Server on your LAN

= Activate a maintained AIMMS license from a previously installed AIMMS
" wversion (3.4 or earlier)

)

< Back [ Next = ][ Cancel Help

20 http://download.aimms.com/aimms/download/data/4.17/1.374/AIMMS_release-Win64_4.17.pdf
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3. Enter your license number and click Next and then select first option if you have received an
activation code.

>

r
License Number

]

S

License Protection

Flease enter the License Mumber of your AIMMS License,

License Number:

[ < Back ][ Mext > ][ Cancel ] [ Help

I

This License is protected by either a dongle or a nodelock,

Please select the option that is relevant to you.

(@ 1 have received an activation code to activate a nodelock license.;

The activation code is a sequence of characters with the following
format: xsonc-XERXXK XXX XN -KXXXXK

() I have received an AIMMS dongle for this license,

A dongle is a small hardware device that you attach to either the
parallel port or a USE port of your computer

[ < Back ][ Next > ][ Cancel ] [ Help ]

h

A

4. Enter the activation code that you received from AIMMS to activate a nodelock license. You
have the choice to request a personal nodelock or a machine nodelock. Personal nodelock is our
preference during development phase since it can be transferred to another computer 3 times
per 24 hours whereas machine nodelock can only be transferred 3 times per 365 days. More
information about their differences can be found in the installation instructions manual. If the
license is valid the subsequent screen will indicate successful installation.

Activation Code

|

Please enter the Activation Code that came with your AIMMS License.

The format of this code is: X0000X00000I0N00OX0O0CI0000

Activation Code:

"] Remember Activation Code (Store in Registry)

< Back ][ Next > l[ Cancel ] [ Help

)

Nodelock Protection

[S5)

AIMMS supparts two types of nodelocks,
Please choose the nodelock type that suits you best.

@ Fersonal Nodelodk (r=commended)i

(71 Machine Nodelock

- Intended for personal use on one or more computers
-Transferrable to another computer 3 times per 24 hours
- Is allowed to change into a Machine Nodelock
-Requires that the computer has Internet access

- Intended for permanent use on a single computer

- Transferrable to another computer 3 times per 365 days
-NOT allowed to change into a Personal Nodelock

- Recommended for server applications

< Back ” Next > ]I Cancel ] [ Help

Successful installation

[=5=)

‘fou have successfully installed a new AIMMS license,

The new license will be added to the list of licenses in the License Configuration
dialog box.

The next time that you startup AIMMS, AIMMS will consider all licenses in the

License Configuration dialog box which have the Default column checked, and
will use the first valid license it finds starting from top to bottom.

Click Finish to exit the Installation Wizard

<gack [ Finish | [ Cancel ] [ Help

I

L

5. The next screen shows the details of licenses installed in your machine. Click Update to
retrieve the latest properties and solvers. It should be noted that the solver configuration
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parameters are contained within the EPN primary database?! rather than being configured
directly through the AIMMS UlI.

License Configuration - ===

Value
021.137.020.001
AIMMS -Development

Defaut liense  Protection Status

02113702000 Llic_ Seninel dongle

None
Dec31, 014
No

Alowed Solvers Netsol
A

AOA
[l F—— 3 CPLEX (Ful)

R F—— i
> ‘ o] o) [ ) e )

6. Once the default and license installation are complete an additional step is needed to map
the POM AIMMS model to the appropriate POM secondary DB.

P Open the .dsn file in the \POM\Data\ subfolder with any text editor e.g. Notepad

i N
[ HMETIMODEL\BCBC_Jan2017_NoConstraint\epdt\porm\DATA\SQL... EE
File Edit Search View Encoding Language Settings Macro  Run
Plugins Window ? X
o ———r —
cEHHE I GE Mkl |t s|BE
[=] saLConnection.dsn £ |
1 [ODBC]
2 DRIVEE=50QL Server
3 UIl=epdtAdmin
2! PWD=Epdtl234
= DATABASE=EPDT-PCOM RZ2.1 (BCBC Jan-2017)
] WSID=BARLONMODETI1
7 APP=RAimm= 4.13
8 SERVER=BARLONMODETI1
Ef Description=53QLServerConn
Ln:10 Col:1 Sel:0|0 Windows (CRLF}  UTF-8 IMS
%

- Update with the appropriate server, WSID (i.e. workstation ID, same as server
name) and database name

21 pom.si_POMGIlobalParameters
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6.1.5. @Risk

@Risk?? 6.2 is used via the Excel GUI for generation the Monte Carlo simulated inputs. Install
@Risk via the default instructions select next with all default settings with the exception of the
“Customer Information” screen where the purchased Activation ID must be entered.

.
1) @RISK 6.2 - InstaliShield Wizard [
Customer Information l
I ||]

User Name:
[baringa

Organization:

Iwant to install a 15-day, full-featured trial.

I'm upgrading or reinstalling my existing 6.x software, and I have already entered a
6.x Activation ID on this machine.

© I want to activate a new license. My Activation ID is:}

[ <Back [ _nNext> [ concel |

>

Following successful installation it is necessary to ensure that @Risk is configured properly in the
main tool Excel Ul (as @Risk is itself an Excel ‘plug-in’ rather than a standalone piece of
software):

P Open the *UI*.xIsm file in C:\EDPT

»  Ensure ‘Data Connections’ and ‘Macros’ are enabled and “Trust access to the VBA project
object model” is checked

- Excel Options -> Trust Center -> Trust Center Settings -> Macro Settings

P Ensure that the following VBA references are checked; Alt-F11 (to open VBA) -> Tools ->
References

- Microsoft Excel 12.0 (or higher) Object Library
- Microsoft ActiveX Data Objects 2.8 (or higher) Library

- Palisade @RISK x.y for Excel Object Library where x.y is the version number
installed locally

- RiskXLA®

P  Save and close the Excel Ul.

6.1.6. EnergyPlus

EnergyPlus?® v8.1 (64bit) is used within the HOM for dynamic building energy simulation. There
are no additional steps beyond the default installation. Click next under all steps with the

22 http://www.palisade.com/risk/

23 Note that when this reference is checked the @Risk excel add-in will automatically load when the Ul file
is opened. If you wish to prevent the @Risk excel add-in from automatically loading then uncheck this
reference and re-save the Ul

24 http://appsl.eere.energy.gov/buildings/energyplus/
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default selections (n.b. ensure that under the final step “Associate *.idf, *.imf, and *.epg files
with EP-Launch is selected)

S
(3 EnergyPlusV8-1-0 Setup =i J

Completing the EnergyPlusV8-1-0
Setup Wizard

EnergyPlusV8-1-0 has been installed on your computer.

Click Finish to dose this wizard.

V]Assodiate *.idf, *.imf, and *.epg files with EP-Launch:

Show Readme

Following successful installation the user needs to replace the Energy+.idd file in the installation
directory with the one contained in the EPDT.zip file.

6.1.7. ETI Thermal Efficiency SAP model

A sub-folder (\eti-te-model\) is included in the main EDPT.ZIP and contains all the necessary files
called by the SAP sub-module wrapper in the EPN tool. The SAP model uses the ETI-TE database
attached as part of the instructions in section 6.1.3.

The filepath for the ETI-TE SAP model also needs to be configured (along with a number of other
3" party components) as outlined in section 6.1.10.

6.1.8. ArcGIS

ArcGIS® 10.2.2 (64bit) is used within the SAM to support the spatial analysis requirements and
spatial elements of the GUI. This includes the Network Analyst and Spatial Analyst extensions
along with the Productivity Suite.

Follow the default instructions to install

P ArcGIS_Desktop_XXX.exe
P ArcGIS_BackgroundGP_for_Desktop XXX.exe
»  ProductivitySuite_vXXX.exe

After default installation is complete, you will need to

P Enter your authorization number for ArcGIS for Desktop via Start -> All Programs ->
ArcGIS -> ArcGIS Administrator.

P Import license for ProductivitySuite via Start -> All Programs -> ProductivitySuit v3.4 ->
Licence Manager.

25 http://www.esri.com/software/arcgis/arcgis-for-desktop
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The EDPT.ZIP contains an ArcGIS Geodatabase folder. Upon opening ArcGIS for the first time it is
also necessary to

P Create a Connection to this folder via the Catalog window

i Help
0GB B e o b P 4T DN e

_ i Nebwork Analyst - | 52| 1% b7

Locatian; [ Folder Connections |

[ Home - My Work Documents|AreGIS
BE e

FiDatais Connect to @ folder or dik.dhive so
Fi\Datalsa wou can work with its contents in the
¥ Catalog,

£ F:\Model|Testing|ArcGISToidNumbers
Toabaxes

Datahase Servers g

Database Connections o

15 Servers B
_ (5] My Hosted Services &

Connect To Folder E

Chaoose the folder ta which you want ta connect:

=]

. R1Deliverables - 20141128 -
. R1Deliverables - 20141205

El
=]

. 52D3 - EnergyPath Design Tool and Libraries
. Data

Attributes For coloring layers
. Building.gdb
. GIS layer attribute kable
. ITM.gdb
. Qutput GIS layers
. Qutput.gdb
. Symbology layvers
. Test network.gdb
. Topography.gdb

Databases
-

Faolder: I FriDeliverablesiRl Deliverables - 2014120515203 - EnergyPath Des

[ake New Folder | Cancel

- 2

P Add the Network Analyst and Spatial Analyst extensions to the basic ArcGIS setup from
the toolbar by selecting Customize -> Extensions
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Select the extensions you want to use.

----- O &rcSean

----- O DataInteroperability
----- [0 Geostatistical Analyst
----- Hetwark Analyst

----- O ProductivitySuite

----- O Publisher

----- [ Schematics

----- Spatial Analyst

----- [ Task Assistant M anager
----- [ Tracking Analyst

----- O wiorkflow b anager

Description:

3D Analyst 1022
Copyright ©1999-2014 Ezni Inc. All Rights Reserved

Provides tools for suface modeling and 3D wisualization.

Cloze

6.1.9. PSS Sincal

PSS Sincal®® 10.5 (32bit) is used within the NAM for steady state analysis of electricity and heat
distribution networks. This includes the Electro and Heating modules.

The user should execute the Sincal autorun.exe file and follow the default installation
instructions under the first tab “PSS SINCAL Platform” -> install

26 http://w3.siemens.com/smartgrid/global/en/products-systems-solutions/software-solutions/planning-
data-management-software/planning-simulation/pages/pss-sincal.aspx
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>

r N
{E PSS SINCAL Platform AutoRun [ 2 [

Welcome to the AutoRun-Program. Here you can choose the products to be installed on your
computer,

PSS SINCAL Platform [ License System | Tools

PSS SINCAL Platform 10.5

S Runs the Setup Maintenance program for PSS SINCAL Platform
‘ I 10.5.
Please note thataspecl cense fesrequred to aperate the

program. For more information about this see the ReadMe fie.

L

¥% Baringa

However, it is important to ensure that the “selected options” do not include “Install 64bit

components

>

727

— .
PSS SINCAL Platform 105 - InstallShield Wizard =

Select the options you want to install.

Select the features you want to install, and deselect the features you do not want to install.

[ 0
[V] PSS PDMS

i [V] PSS NETOMAC

[ Install 64 bit components

[ Install PDF documentation

[ < Back " Next> II Cancel l

Depending on type of license, the WIBU-key dongle driver or PSS Sincal Platform License Server
needs to be installed. This process is initiated by selecting the “License System” tab on the first
autorun window and following the relevant instructions (which depend on the license type the
user has purchased)

>

. .
[l PSS SINCAL Platform AutoRun =

Welcome to the AutoRun-Program. Here you can choose the products to be installed on your
computer.

PSS SINCAL Platform | License System | Tools |

WIBU-Key
Runs the WIBU Software Setup program.
This software is only necessary if you use a WIBU-Box (dongle)

license.

PSS SINCAL Platform License Server

5 Runs the License Server Setup program.
S| This software is only necessary if you use a network license. The

License Server has to be installed on one Server Computer, only.

After installing Sincal it is necessary to:

P Open the main Sincal Ul to complete the configuration

27 This is for compatibility reasons, due to the use of CScript to run the VBS-based COM objects for the
automatic wrapping of Sincal in the NAM.
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- From the toolbar select -> extras -> options ->Database configuration-> SQL
server and connection details as per those used in 6.1.3

- This automatically creates the final SINCAL_DATABASES DB

CEE

8 B-|lA@WE|GESE B k-

Dptions - Database Configuration

[E Application
- User Interface
- Data Modification
Shartout Keps
- User Menus
- Macros
Directories
- Background Maps
" Database

& [ atabase Configuration
Default Standard Databases
iz License

Common I

Detault Databaze System:

€ Micosoft ccess
% G0l Senver Exnress

SOL Server Configuration +

IBAHLDNMDDETH
Iepdladmln

Service name:
User name:

Password:

[2]x]

£ [iacle
& 5L Server

I™ Save passward

Test | whark Llser. I

I Database system can be selected optionally

Cancel

»  Within the EDPT.ZIP there are two additional .sin files required by Sincal, which must be
located in the same directory as their corresponding DBs (these should automatically be
extracted to the relevant directories by default when the ZIP files is uncompressed)

- SINCAL_ELEC_SQLSERV DB and SINCAL_Elec.sin
~  SINCAL_HEAT SQLSERV DB and SINCAL_Heat_SQLServ.sin

P If the NAM is to be used in multicore mode for load flow analysis (NAM001, NAMOO3,
NAMOO5) the databases SINCAL_ELEC_SQLSERV DB and SINCAL_HEAT_SQLSERV DB must
be detached and copied to produce a database for each core, named in format
SINCAL_ELEC SQLSERV_1, SINCAL_ELEC SQLSERV 2, etc.

6.1.10. Tool setup and configuration

Upon completing the installation of the underling software there are two further setup steps:

P Update the Edpt.ini file (included within the EDPT.zip) - where necessary - to reflect
- The installed file paths for the 3™ party software
- The names of all EDPT DBs
- The path to the ArcGIS data folder

P In the main Excel Ul on the Database Manager screen complete the DATABASE

CONNECTION SETUP details with the relevant parameters from section 6.1.3

— Click Connect to confirm successful connection and the save the Excel Ul file
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It should be noted that the Excel Ul only needs to be connected to the Primary
and POM Database and not the secondary HOM, SAM, NAM or supplementary

SINCAL database.

v 7N
tef:hnﬁ;rigg === Iéem‘“ek!g J el

institute

DATABASE CONNECTION SETUP

Connection Status:

SQL Server Namellnstance: [CILMIAIET]
Primary Database Name: [S3iBanas B RRG3)
POM Datsbace e

6.2. Parallel computing setup

The base setup for the non-master machine (2) is identical to the master machine (1), but only
requires a copy of the POM model files and associated software. To complete the setup two
further steps must be undertaken

P Update Windows Remote Management configuration on both machine (1) and (2)

Open DOS command prompt
Type: winrm quickconfig

o, n

Select “y” twice

AIMMS will need to use more than the default limitation of 150MB memory and
this can be increased to e.g. 80%+ of the machines’ available memory in MB

Type: winrm set winrm/config/winrs @{MaxMemoryPerShellMB="XXXXX"}

P In the main Excel Ul — stored on the master machine (1) go to the [Model] -> [Database
Manager] screen and complete the AIMMS SETUP boxes for Machine 1 and Machine 2
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AIMMS SETUP for Machine 1
Setup Status:
LLET L B T BPL-1616
Path to AIMMSCmd.exe
Remote path to AIMMS project folder:
Local path to AIMMS Project:
First Sim:

N —
Last sim: [
R 2 —

AIMMS SETUP for Machine 2

Remote path to AIMMS project folder:
Local path to AIMMS Project:

First Sim:

Last sim: |

1
1
Machine name:  [E1{0 150
F! g puting\p

R G LR G RS TR C AProgram Files'\Paragon Decision Technology\AIMKS 3.14\Bim\AimmsCmd. exe

These configuration boxes also control the first and last (consecutive) simulations which are run
on each machine. For example if you wanted to split 100 simulations you would Assign First/Last
Sim as 1/50 to machine (1) and 51/100 to machine (2)

6.3. Known software issues

The following are known software issues:

P Multi-processor support in @Risk should be disabled (Nb not all versions of @Risk have
this functionality and hence it may be disabled by default). To do this the user should

- Open the Excel Ul and run @Risk from the start menu to load the plugin

- Select

= [HH9-®-s

m Home Insert Page Layout Formulas Data Review View Developer Add-Ins @RISK
% % ' !! Iterations 100 - o g E summary

e A & A A

] : —_— Simulations 1 - S Define Fil

Define Add Define  Distribution | Model Start Advanced | Browse S
] d . R
i Distributions Qutput Correlations  Fitting = Window L’ éd E i @ Simulation Analyses = | Results E

| Model A Simulation | Results

3 a3 v

- Ensure “Multiple CPU Support” is set to Disabled

W

iew | Sampling | Macros I Convergence |

Simulation Runtime

Number of Iterations 100 -

Number of Simulations |1
Multiple CPU Support IDisahIed vl

- Close and Save the Excel Ul
P The Euro-Tool Excel Add-in should be disabled. To do this the user should
- Open the Excel Ul and go to File -> Options -> Add-Ins -> Go
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Add-Ins

Add-Ins available:

T —
| Analysis ToolPak - VBA
[ |Euro Currency Tools
(V| Master Redpainttemplate_v1_4
(V| Redpointtemplate_V1 4
(V] Solver Add-n Bowse...
Analysis ToolPak

Provides data analysis tools for statistical and engineering

analysis

- Uncheck the “Euro Currency Tools” box (if ticked) and select “OK”

- Close and Save the Excel Ul

ETI SSHP — EnergyPath Networks — Technical Design and User Guide 47/118

Baringa Partners LLP is a Limited Liability Partnership registered in England and Wales with registration number 0C303471 and with registered offices at 3rd Floor, Dominican Court, 17 Hatfields, London SE1 8DJ UK.




¥% Baringa

7. Overview of User Interface (Ul)

7.1. Main Excel Ul

The Excel Ul is only designed to facilitate more convenient operation of the tool by an expert
user, as it has limited development focus to this point. Its primary roles are to:

P Facilitate the process execution of the tool (including @Risk) by calling the Master
Control Framework

- This includes basic logging information on progress and errors

P Enable the user to add, update, delete information in the primary database without
having to access this directly

- Simple and configurable functionality is included to allow the user to read and
write subsets of data to individual tables rather than having to work with the
entire table contents at once

P Allow the user to interrogate POM results via a number of predefined results tables and
charts, which are updated automatically with data from the primary database

The Excel Ul works in conjunction with the ArcGIS Ul, as there are a number of user steps (see
section 7.2) that are undertaken through this. These ultimately lead to additional or updated
information sent to other sub-modules within the tool.

7.1.1. Navigation

The Ul navigated via a menu bar within “Add-Ins” tab, containing drop-down options and further
sub-menus.

Developer Add-Ins @ERISK

Format Table Model =~ MCF~ HOM = SAM ~ NAM * POM =~ Simulate * Run = Results = Admin -
> @ Read from Database ;i:l Commit to Database

The [Model], [Simulate], [Run], [Results] and [Admin] drop downs and their sub-menu options
contain bespoke screens. The other drop downs provide a navigation framework, which re-uses
the same ‘flexible data entry screen’, but applying different configuration parameters to it (e.g.
the choice of table to view) when the sub-menus are selected. These screens are described
further in section 8.

It is generally better to work top to bottom and left to right across the menu items - particularly
when adding new elements such as new products - as validation and filtering checks are
undertaken by the Ul and DB based on these entries.

Additional toolbars are activated upon selection of a new screen depending on the screen type

P Inputs Toolbar — activated where data can be added/modified/deleted on an input
screen

=’ Read from Database #3 Commit to Database

ETI SSHP — EnergyPath Networks — Technical Design and User Guide 48/118

Baringa Partners LLP is a Limited Liability Partnership registered in England and Wales with registration number 0C303471 and with registered offices at 3rd Floor, Dominican Court, 17 Hatfields, London SE1 8DJ UK.




¥ Baringa

7.1.2. GUI formatting conventions

The following cell formatting conventions are used throughout the UI.

; Minimum Build Quantities
. energy Techolosy [ ©

Micro Solar PV ~
teChno.logies Micro Solar Thermal (non south fadng)
institute Micro Solar Thermal (south fadng)

Micro Wind
Mucdlear

OCGT
Offshore Wind
Cil Boiler - Hot Water

Flag |Delete? |Minimum

1. Input cells — data in white cells can be edited by the user
2. Formula cells — grey cells contain formulas
3. Table headings — blue cells with white text show table headings

4. Custom formatting — some cells use conditional formatting to highlight specific
information, such as the presence of duplicate entries, which must be corrected before
the data is allowed to be written to the Database

5. Drop down (combo) boxes

— The user can pick from a pre-defined list of entries

- The data displayed on the worksheet will be filtered according to the current
drop down box selection

7.1.3. Reading and writing to the database

Upon selecting a new worksheet via the menu bar as described in section 7.1.1, that worksheet
will be refreshed automatically with data from the currently active database.

P Any worksheet containing data retrieved from the database can be refreshed by clicking

the = Readfrom Database . = Refresh Data 1 1161, from the toolbar just below the main
menu.

- Shortcut: Ctrl + Shift + R

» Equally, modified data can be written to the database by clicking the
;:‘: Commit to Database button
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- Upon clicking this button, the user will be prompted to confirm the database
write operation via a pop-up window. The pop-up message highlights that that
there is no undo option —i.e. any modifications to existing data or the deletion
of existing data is permanent.

— If there are errors on the sheet an alternative pop-up window will notify the
user that the database write cannot occur until the current errors (as indicated
by conditional formatting) have been resolved.

- Shortcut: Ctrl + Shift + C

7.1.4. Adding, modifying and deleting input data
Each input table generally has the following characteristics:
1. Adata input range where new data can be added or existing data modified.

- To modify a saved record, simply edit the existing data in the data input range.

- Anew record can be created by adding data to a blank row at the bottom of the
data input table

2. A “Flag” column which highlights whether a record has been added (New), changed
(Modified), is for deletion (Delete) or is unchanged from the existing record in the
database (Saved).

3. A “Delete?” column which enables the user to select to delete an existing record

- Double clicking a cell within the Delete column will add/remove a tick mark.
When a tick mark is present that record will be formatted with a grey font and
the corresponding cell in the Flag column will show “Delete”

. Minimum Build Quantities

?y@rgy Technolosy [ 1
technologies

institute

Flag |Delete?

After entering new data, modifying existing data or marking existing data for deletion the user
must click on Commit to Database for these changes to take effect.
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7.2. ArcGIS Ul

The EPN tool involves a number of tasks and inputs related to the Spatial Analysis Module (SAM),
for which the user needs to interact with ArcGIS:

Core setup of underlying data

A. Load Ordnance Survey (OS) data into ArcGIS
B. Add new build information to OS data (individually or en-masse)
C. Create a network dataset using road information (ITN) from OS

Modification of ‘unit-level’ energy system data

D. Identify demolition of existing building stock, existing PV uptake and uptake of electric
vehicles (over time)

E. Define polygon packages for non-building, non-network energy system features

F. Define other known building attributes (individually or en-masse and including grid-level
connections for non-domestic buildings)

G. Define existing electricity / heat network features

Definition and modification of ‘cluster-level’ energy system data

H. Create clusters (from HVS level downstream and more disaggregated), assign cluster
attributes and constraint classes (represent building archetype, network and
technology/storage packages constraints)

- This includes multiple scenario cluster definitions
I. Define inter cluster connections (heat/gas), and potential meshing options (electricity)
- This includes multiple scenario cluster definitions

Viewing Spatial Results

J.  View spatial results from POM

Steps A. to C. will effectively only need to be undertaken once for a given area, whilst the
remaining steps could be subject to revisions to test different sensitivities or scenarios. Where
these steps fit into the overall tool process flow is shown in section 4. They are in sequential
order for the full pass through the tool and are grouped into steps which would be undertaken
at the same time in the process flow.

Each individual ArcGIS process step is described in more detail under the sample use cases in
section 9, however, it is assumed that the user already has a basic familiarity with the ArcGIS Ul,
e.g. in terms of standard approaches for editing layers.
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8. Overview of specific Excel Ul screens

8.1. Flexible data entry screen [MCF to POM menu items]

The main data entry screen is set up to be able to interrogate any si_ (set) or pi_ (parameter)
tables - i.e. those that require direct user inputs. It is not intended to access other primary DB
tables used for other purposes (e.g. pc_ tables which contain intermediate calculated data being
passed from one module database to another)®,.

technologies

Uinstitute  Tech cHP_aAs [~] sasebuilavesr P €3
BaseChay (RN ©

seseournarimes I 1

il [Availabili

Saved
Saved
Saved
Saved
Saved
Saved
Saved
Saved
Saved
Saved
Saved
Saved Winter_Weekday
Raved CHP GAS Winter Weekday

For pi_ tables the user can, via the [Parameter Data Config] menu screen define a number of
possible filters, based on the sets relevant to that table, which can be used within the main data
entry screen to read and write a subset of the pi_ table only.

For example, the pi_TechAvailabilityFactorsTS table is comprised of >10° rows, but it is defined
by a number of pieces of si_ set information related to:

P Tech (i.e. technology name]

P BaseCDay (i.e. Characteristic Day)

P BaseBuildYear (i.e. to reflect different technology vintages)
P BaseDiurnalTimeslices (i.e. half hours of the day)

In this example the user has configured filters for the first 3 of these and is applying them with
si_ values set for CHP_GAS/Winter_Weekend/2014 respectively, to pull back and adjust a subset
of the data in pi_TechAvailabilityFactorsTS. As no value has been set for BaseDiurnalTimeslices
filter all half hours are returned for entries which match the other filtered criteria.

2 |t is also configured to view (but not edit) a number of (vi_) information views, which are used to
summarise data from a number of tables in a more convenient format.
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Once the user has updated any of the values, the “Commit to Database” button only updates the
subset of data selected here, i.e. all other pre-existing data in the table remains unchanged.

MCF to POM menu bar

The sub-menu ordering is designed to reflect the most appropriate way to enter new data to
given consistency across the tool (i.e. you cannot define the costs for building new Technology Z,
until you have first created new Technology Z) .

When adding new elements to the model (as opposed to modifying values associated with
existing elements) the user should work from top-to-bottom, left-to-right from the MCF to the
POM menus.

e Insert Page Layout Formulas Data Review View Developer Add-Ins @RISK

[ndex |_] g Mew release ~ Insert Sheets = Redpoint Styles: Background.. ~ Format Table Model ~ HOM = SAM ~ MAM ~ POM = Simulate = Run =~ Results = Admin =

ael cells Update Chart colours Global configuration 2 pi_GlobalParameters
+= Graph Export Location Current Slide  ~ Chart Export Height [cm)  Default - Temporal configuration » pi_ProcessDefinition
Custom Toolbars
Products L4
- % |
PolygonPackages 3

Base Archetype Characteristics

Base/Reduced Archetype Configuration

MNon-domestic building archetypes

(ﬂergy Database Manager

technqlogies Existing electricity substations
institute

Cluster Constraints

DATABASE CONNECTION SETUP

Connection Status: [«e]{[[|30}3r]
SQL Server Namelinstance: [EEGINe}| {o]/r3)v4
LG ELEEEE B A EPDT-Primary_v0.1.11 (Master+Data

It is important to note that all sub-menu options moving from the MCF button through to the end
of the POM sub-menus buttons are re-using the same underlying flexible data entry screen
described above. However, depending on the sub-menu option selected the data entry screen
options are reconfigured accordingly (e.g. the drop-down filters are updated to reflect those of
the specific data table selected by the sub-menu).

8.2. [Model]

8.2.1. [Database Manager]

This is the same screen as that shown in section 6.1.10 and is used to connect the Excel Ul to the
relevant SQL server instance and primary database.

8.3. [Simulate]

8.3.1. [Monte_Carlo — Set/Parameters and associated sub-menus]

These re-use the flexible data entry screen described in section 4.1 and allow the user to
enter/delete/modify the input data relevant to the Monte Carlo parameters.
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8.3.2. [Simulation Manager]

This screen allows the user to configure and execute the setup parameters associated with
generating the Monte Carlo inputs. The “Run Simulation” button simply generates the simulated
inputs, which are used by other parts of the tool (as controlled by the process execution flow
under the [Compute] screen).

energy | Simulation Manager '
technologies

' institute

Number of Simulations: | ERGENGG_.
Fixed Random Number Seed: TRUE 1 Seed: JNEECNE
Sampling Type| Monte Carlo 1

-

Run Simulation

1 # Simulated
Custom Indices
Generic Indices

8.4. [Run]

8.4.1. [Process Flow]
This screen contains an interactive process flow which allows the user to:

1. Remotely execute different parts of the tool by clicking on the process flow boxes
(including batch processes related to multi-scenario data configuration) and understand
the ordering of sub-module process steps and associated dependencies

2. Understand which process steps need to be re-run if they change given input data (and
simplify the process

N\ ) Networks g g
Tl
Identify steps to rerun given data change Module Status

-

 —
Steps to re-run: sam
—
=
POM

Input data tables updated Propagate changes to Secondary DBs

Name

Each of these areas in described in more detail below
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Running the tool via the interactive process flow diagram

The interactive process flow diagram in the Ul screen mirrors that in section Figure 4-1. Clicking
each box in the process flow diagram remotely executes the relevant sub-module APIs in the
EPN tool. The initial colour coding of the boxes highlights which part of the tool each sub-
module relates to; as the user works their way through the process flow, selecting each box, the
colour coding updates to reflect their status.

For example, after selecting the “Start (initalise PDB)” box the colour will change to black to
indicate that the process is running. If this process successfully completes it will change to green
and also highlight the subsequent steps which can then be run in blue.

( DEnergyPat e

institute.

Identify steps to rerun given data change Module

Household OptionsModue
 Initialisation
(HOM-000)

Steps fo re-un-

Start
(initialise PDE)

‘Spatial Analyss Module
(sAM-000)

Input data tables updated Propagate changes to Secondary DBs

Multiple blue next steps indicate that these can be undertaken in parallel, up to the point where
there are multiple dependencies. In the example below it is now assumed that the user has
successfully run SAM-000. However, before SAM-002 can be run both SAM-001 and HOM-000
must successfully be completed. If the user tries to run SAM-002 before all relevant preceding
steps have successfully completed a warning message will be shown.

= ,_
( DEnergyPat Gy

institute

Run Tool Reset process flow

Identify steps to rerun given data change Module Status
Household Optiens Moduls
Sch o - Initialisation
Table / Su - Hon-000)

= P
ory - oM001)
Steps to re-run: o
[
NAM
FOM Failure
Map existing ares Domestic building
Spatial Analysis Module topology and -
(SAM-000) export s
Mente Carlo (sAM-001)

Where a step fails to complete successfully the user will need to investigate the causes of this
(e.g. looking at the EPN tool log files for information) and correct the issue (e.g. data
inconsistencies) before re-running the step.

Some process steps are bounded by a wider process box to indicate that these process steps can
also be set to run automatically in a batch across data for multiple scenarios that the user has
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